
Executive Summary
The right device can make you a healthcare IT hero by allowing clinicians and staff to work smarter, not harder. 

For instance, when you equip users with rich-client devices instead of zero-client devices, you empower them 

to transcribe exam notes up to 51 percent faster! This was one of the results we saw when we assessed the 

performance of rich-client devices, including a tablet and an all-in-one device—a popular option in healthcare 

today—against a zero client for performing common healthcare tasks. The devices we examined were: 

•	A Lenovo® ThinkCentre® M900z all-in-one device powered by an Intel® Core™ i5-6500 processor with  

Intel® vPro™ technology

•	A Lenovo® ThinkPad® X1 Tablet powered by an Intel Core m7-6Y75 processor with Intel vPro technology

•	A zero client with a virtualized desktop hosted on a server running Windows® MultiPoint® Server 2012

Our Primary Diagnoses
•	An all-in-one rich-client device, such as the Lenovo ThinkCentre M900z all-in-one we tested, can help office 

staff add and check in new patients faster and more efficiently than a zero client.

•	Rich-client devices let doctors and technicians view images in medical-image processing software faster,  

and more efficiently consult with others about those images, than zero clients.

•	Zero clients fall short for using some technologies and typically take longer than rich-client devices  

to complete tasks.

DIAGNOSING WHICH DEVICES PROVIDE  
MORE FOR HEALTHCARE

Faster image rendering
on rich-client devices

More time saved 
when using rich-client devices

Broader options 

with rich-client devices
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Clinicians Are More Efficient with the  
Right Digital Options
Medicine today is solidly entrenched in the digital age. IT decisions have a big impact on 

enabling clinicians and patients to spend less time waiting—time that can then be used to 

deliver or receive care. Choices for IT are broad: local software, software as a service (SaaS), 

rich clients, thin clients, zero clients, traditional infrastructure, virtual desktop infrastructure 

(VDI), and the cloud.

To help you with one of those choices—how to best equip the clinicians and staff with the 

right devices—we compared the performance of rich-client and zero-client devices when 

performing healthcare tasks using leading medical software solutions.

Our tests show that while zero clients running in a virtualized environment might seem like 

a sound choice for clinical settings, zero clients do not stand up to rich-client devices for 

efficiency or flexibility. Zero clients might be well suited for some needs, but today’s healthcare 

professionals need more performance and flexibility than zero clients provide. We found that 

those performance and flexibility needs are best satisfied by rich-client devices.

Start Off Right with a Good Patient  
Check-in Experience
In our test scenario, a large health facility wants to automate the patient check-in process with 

a single solution that could be used by administrative staff as well as by patients to check 

themselves in. The facility chose Savance Health solutions, which are used by hospitals and 

clinics throughout the U.S. to streamline operations, improve the patient experience, save time, 

and reduce costs. 

Because the patient experience starts when a patient first arrives, we started our testing with 

the Savance Health Patient Self Check-In solution. We examined how the process works for 

both patients and admins using our two rich-client devices and the zero-client device.

In our test scenario, a new patient, Betty Marshall, arrives at a clinic.1 Betty has two options  

to check in.

1.	 She can use a device located in the waiting room.

2.	 She can go to the front desk and check in with the admin.

Because Betty is a new patient, she checks in at the front desk. The admin, Mike, welcomes 

Betty, learns that she’s a new patient, and uses the Savance Health solution to create a record 

for Betty in the clinic’s system.1  

Speed Up the Time It Takes to Add New Patients
In our test, Mike adds Betty as a patient on the zero-client and rich-client devices. Mike is able 

to add Betty faster and more efficiently using the Lenovo ThinkCentre M900z all-in-one device, 

powered by an Intel Core i5-6500 processor with Intel vPro technology, than he can using 
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the zero client. While the time savings are 

fairly small for one patient, if Mike checks in 

eight patients a day for five doctors, over the 

course of the average 261 working days for 

2016, he will save almost an entire day (7.74 

hours) by using the all-in-one device instead of the zero client.

Make It Convenient for Everyone, Let Patients  
Check Themselves In
Shortly after Betty checks in, a current patient, Don Anderson, arrives for his appointment.1  

Don can use either a zero client at a workstation or one of the rich-client tablets located on 

end tables throughout the waiting room to check himself in. In our test, using the tablet and 

its touch capabilities, Don takes just 22.65 seconds to check in—less than half a minute. The 

zero-client device that we tested doesn’t support touch capabilities, so Don has to go to a zero 

client located at a workstation and wait in line.

MAKE IT CONVENIENT FOR THE PATIENT

Mike’s clinic considered a zero-client setup for patient check-in. In the end, the clinic opted to 

give staff and patients the convenience of using either a touch or keyboard interface. It chose 

the Lenovo ThinkPad X1 Tablets for Savance Patient Self Check-In in the waiting room due to 

the device’s lighter weight and portability. 

MAKE IT CONVENIENT FOR CLINIC STAFF

Because Don is an existing patient, letting 

him check himself in saves Mike, the  

admin, the time needed to check Don in. If 

Mike were to check Don in using his all-in-

one device, it would take Mike just 19.89 

seconds with the all-in-one’s keyboard. 

This means that by enabling Don to check 

himself in, Mike saves roughly 20 seconds every time a patient uses Savance Health Patient 

Self Check-In on one of the tablets in the waiting room. If 40 patients check themselves in 

every day, that saves Mike 13.26 minutes every day; over the course of a year, that equals 

57.68 hours or 7.21 work days saved.

When Mike does have to check patients in—for instance, when all the tablets are in use, or 

when a patient prefers to talk with Mike—he still saves time by using his all-in-one device 

compared to the time it would take to use a zero-client device.

MAKE IT CONVENIENT FOR THE IT TEAM

Choosing rich-client devices over a zero-client environment not only saves time and adds 

convenience for the clinic’s staff and patients, it also lets the clinic’s IT team avoid the hassle 

of buying, installing, and maintaining added peripherals—such as a monitor, keyboard, mouse, 

Admins can save almost 
a full day (7.74 hours) 
each year using a rich-client 
device to add new patients.

Save of�ce staff up to 7.21 
work days annually by 
equipping patients with the 
ability to check themselves in.
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and camera—as well as buying, installing, and managing the equipment needed to support 

a virtualized environment. Peripherals are not included with zero clients and would have to be 

purchased, installed, and maintained separately.

Zero Client a No-Go for Patient Check In
Based on our results, our conclusion is that rich-client devices offer more for patient  

check-in: more convenience and more efficiency. The ability to complete check-in faster, in 

addition to the ability to use touch capabilities and built-in peripherals, made these devices  

the best choice in our estimation.

Enable Faster Patient Tracking  
and Flow
Once our new patient, Betty, is registered as a patient, Mike sets her status 

in the Savance backend to “Sign In.” This status carries over to Savance 

Health Patient Tracking & Flow, a comprehensive, easy-to-use patient-

tracking software that is designed to help hospitals and other healthcare 

facilities improve the effectiveness and efficiency of workflow processes 

and clinical procedures. 

In our tests, Mike can set Betty’s status using his Lenovo ThinkCentre 

M900z all-in-one in just 7.46 seconds—4.29 seconds, or 37 percent, faster 

than if Mike were using a zero client. Mike uses a second monitor with 

his all-in-one. This way, he has the Savance Health solution open on one 

screen and his email open on another. He does not have to spend time 

switching between applications. 

To gain the same benefits with a zero-client device, IT would first have to 

buy not one but two monitors for Mike to use. Mike’s zero-client has fewer 

ports than the all-in-one, so he might use up all of his ports, because he 

needs at least a printer and scanner in addition to his extra monitor. 

After Mike has Betty checked in, a medical assistant, Susan, takes  

Betty to an exam room.1 Susan has access to Savance Health Patient 

Tracking & Flow on the Lenovo ThinkCentre M900z all-in-ones located in each exam room. 

She also has access to the Savance Health solutions on a Lenovo ThinkPad X1 Tablet, 

powered by an Intel Core m7-6Y75 processor with Intel vPro technology, which she uses as 

she moves among exam rooms and patients.

After Susan has Betty settled, she changes Betty’s status in Savance Health Patient 

Tracking & Flow to “Waiting.” Susan does this on her Lenovo ThinkPad X1 Tablet in just 5.78 

seconds—1.68 seconds faster than if she used the all-in-one in the exam room, but 5.97 

seconds, or 51 percent, faster than if she were using a zero-client device. 

SAVANCE HEALTH 
SOLUTIONS 
Savance Health (www.
savancehealth.com) provides  
a line of Health Insurance  
Portability and Accountability 
Act (HIPAA)–compliant software 
solutions to help hospitals and 
other medical facilities save time 
and money while improving the 
work environment and the patient 
experience. From the moment that 
a patient arrives at a facility until the 
time that patient leaves, Savance 
Health solutions aim to simplify 
processes, collect crucial data, 
improve efficiency, decrease patient 
wait times, and increase overall 
patient satisfaction (and Hospital 
Consumer Assessment  
of Healthcare Providers and 
Systems [HCAHPS] scores).
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With the Lenovo ThinkPad X1 Tablet, 

Susan gains the convenience of 

mobility in addition to being able to 

complete her tasks fast. And if Susan 

assists two doctors who each see 

eight patients each day, that savings gives Susan an extra 6.93 hours annually to do other 

things. Susan is just one of the clinic’s three medical assistants who assist a total of five 

doctors with 40 patients a day, so the clinic overall saves 17.31 hours annually.

Rich-Client Devices Let Staff and Patients Spend  
Less Time Waiting 
The numbers prove it: the rich-client devices powered by Intel® Core™ vPro™ processors that  

we tested let clinicians and support staff—and therefore their patients—spend less time 

waiting. What’s more, these rich-client devices come with monitors and keyboards along  

with ports for connecting additional monitors, printers, and other peripherals. When mobility  

is important, or even just a nice convenience, an Intel® processor–powered tablet empowers  

the clinic’s team members to do their computer-based tasks on the go. Conversely, the zero 

client we tested is slower, stationary, does not support touch capabilities, and would require 

added cost and configuration time to equip it with a monitor, keyboard, and other peripherals.

Empower Clinicians to Spend Less 
Time Transcribing Exam Notes
Clinicians must capture accurate information about their patients—not  

only to deliver the best care, but also to ensure regulatory compliance.  

To capture patient information, many doctors choose to record notes 

verbally and later transcribe them for inclusion in the patient’s electronic 

health record (EHR).

To see how our test devices compare for recording and transcribing patient 

notes, we chose Dragon® Medical Practice Edition from Nuance. Dragon 

Medical Practice Edition is a leading clinical speech-recognition solution 

that interoperates with all major EHR platforms.

In our scenario, Dr. Zone records notes from Betty’s exam in the exam 

room.1 He asks Susan to transcribe the recording after the exam and to 

ensure the transcribed notes get added to Betty’s EHR. 

In our tests, we discovered that while we were able to get Dragon Medical 

Practice Edition to run on our zero-client device, Nuance does not provide 

support for Dragon Medical Practice Edition on zero clients. Clinics 

choosing a virtualized environment with zero clients would have to choose 

to run Dragon Medical Practice Edition without support. 

Enable medical assistants to 
update patients’ statuses up to 
51 percent faster with an Intel® 
processor–powered rich client.

DRAGON® MEDICAL
Dragon Medical speech 
recognition solutions empower 
clinicians to deliver more accurate 
documentation without disrupting 
their workflows, so they can 
spend more time with their 
patients. Dragon Medical 
solutions are in use at more 
than 10,000 healthcare facilities, 
and they are used by more than 
500,000 physicians worldwide.

Dragon Medical Practice Edition 
(http://www.nuance.com/products/
dragon-medical-practice-edition/
index.htm) is designed and priced 
exclusively for independent 
practices of 24 physicians or less.

Nuance offers a wide range  
of speech-recognition solutions  
for healthcare, including  
cloud-based, on-premises,  
hybrid, and mobile solutions.
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We also found the Intel processor–powered 

Lenovo rich clients outperformed the zero 

client for this task. Susan is able to use the 

automated “Transcribe Recording” feature to 

transcribe Dr. Zone’s 93-second recording 

of the notes on the all-in-one in her office. Completing this task takes Susan just 37.16 

seconds—48 percent faster than if she uses the zero client. If she were away from her office 

with her Lenovo ThinkPad X1 Tablet in hand, she would still complete the transcription faster 

than she could with the zero client—29 percent faster at 50.84 seconds compared to 72.05 

seconds on the zero client.

The time saved for Susan is dramatic when extended 

out a year. If she uses the all-in-one device to transcribe 

two doctor’s notes for eight patients each day, Susan will 

save an entire week—40.47 hours—a year. That is a week 

she can spend caring for patients instead of working on 

administrative tasks. And remember, our clinic treats 40 patients each day, so the clinic  

could save 101.18 hours, or 12.65 work days each year!

Table 1. Time saved when transcribing recorded exam notes in Dragon® Medical Practice Edition using Lenovo® 
devices powered by Intel® processors compared to a zero client

Percent Faster 
Than the Zero 
Client

Time Saved Daily 
If Transcribing 
Notes for 16 
Exams

Time Saved 
Annually for One 
Medical Assistant

Time Saved 
Annually for 
Three Medical 
Assistants 
Treating 40 
Patients per Day

Lenovo® ThinkCentre® 
M900z all-in-one device, 
powered by an Intel® 
Core™ i5-6500 processor

48% (37.16 
seconds vs. 72.05 
seconds)

9.30 minutes 40.47 hours 101.18 hours

Lenovo® ThinkPad® 
X1 Tablet, powered by 
an Intel Core m7-6Y75 
processor

29% (50.84 
seconds vs. 72.05 
seconds)

5.65 minutes 24.60 hours 61.51 hours

Rich-Client Devices Reduce Time for Patient Care and Ensure 
Software Is Supported
Our results show that transcribing exam notes with the rich-client devices powered by Intel 

processors let clinicians and support staff spend more time on patient care and less time on 

administrative overhead, compared to the zero-client device. And even though we were able to 

get Dragon Medical Practice Edition to run on our zero-client device, Nuance does not support 

running Dragon Medical Practice Edition on the zero-client device we tested.

Save 40.47 hours annually 
by empowering one medical 
assistant to transcribe exam 
notes in Dragon® Medical Practice 
Edition on an all-in-one rich client.

Dragon® Medical Practice
Edition is not supported 
on the zero-client device 
we tested.
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Deliver Better Quality and Faster 
Access to Medical Images 
Medical images—photos, X-rays, magnetic-resonance images (MRIs), 

ultrasounds, and more—are an integral part of medicine. To test viewing 

medical images, we used ObjectiveView™ digital-pathology image viewer. In 

our scenario, Don has been suffering from upper back pain, and Dr. Zone 

wants an X-ray image of his spine. Jim, the X-ray technician, takes an X-ray.1 

He wants to consult with Dr. Zone before he concludes Don’s X-ray and 

sends Don back to Dr. Zone’s office.

In our tests, Jim notices significant image degradation on the zero  

client, even when he tries it with different monitors. The image is pixelated 

on all monitors, and it renders with an incorrect aspect ratio on some. 

Pixelation can be especially problematic in black-and-white medical images 

because it impedes Jim’s and Dr. Zone’s ability to distinguish noise from 

signal. They might not be able to tell if a dark image in the bone is pixelation 

or if it is localized bone decay or a small fracture. Because the rich-client 

devices render images more clearly, they make it easier to make accurate 

diagnoses and, therefore, provide better patient care.

In our tests, Jim opens and annotates the X-ray in ObjectiveView image viewer in just 36.17 

seconds using the Lenovo ThinkCentre M900z all-in-one device. The same flow on the Lenovo 

ThinkPad X1 Tablet takes roughly five more seconds at 41.38 seconds, and it takes almost six 

seconds longer on our zero client at 42 seconds. If Jim uses his all-in-one instead of a zero 

client, those six seconds, extrapolated out over 16 patients per day, will net Jim an extra 6.76 

hours annually. Those are hours he can spend helping patients, validating images, and more.

And if we add the time saved on retaking 

images to verify whether pixelation is 

noise or an actual issue, Jim saves even 

more time each year, as do Dr. Zone and 

the clinic's patients.

Rich-Client Devices Enable Time Savings and Added  
Quality and Flexibility 

In our test scenario, if Jim’s clinic equips him with the Lenovo ThinkCentre M900z all-in-one 

device that we tested, the device’s built-in 23.8-inch monitor lets Jim see the granular detail he 

needs to assess if a doctor consult or additional images are needed. The magnifier tool works 

smoothly on the rich-client device as he moves his mouse to zoom in on specific areas of the 

image. Jim can view images and make annotations faster with the rich client than he can with 

the zero client. And, he will not waste valuable time because of the image degradation that we 

saw with the zero client. 

OBJECTIVEVIEW™ 
DIGITAL PATHOLOGY 
IMAGE VIEWER
ObjectiveView image viewer 
(http://www.objectivepathology.
com/#!objectiveview/c3zr) is a 
vendor-neutral software solution 
from Objective Pathology that lets 
clinicians view digital-pathology 
images locally.

Objective Pathology offers 
network, image storage/
management, hosting, and mobile 
web-based applications that allow 
pathologists, researchers, and 
educators to connect and make 
digital pathology immediately 
accessible for anyone who can 
benefit from the technology.

Viewing medical images on an 
Intel® processor–powered 
all-in-one rich-client device, 
one technician can save 
6.76 hours annually
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If a facility needs nothing more than an image viewer that integrates with its picture-archiving-

and-communication-system (PACS) or electronic medical record (EMR) platforms, a zero  

client might be sufficient (although the facility will want to take care that images are not  

distorted by the chosen monitor), but zero clients can be limiting for users who depend on 

image quality and need to complete tasks faster. To provide users with the greatest efficiency, 

we recommend decision makers consider outfitting their environments with Intel processor–

powered rich-client devices. These devices can be managed using standard Microsoft® 

environment-management tools, which can help ensure the facility’s compliance officer  

that patient data is secure and protected by the same policies that manage other devices  

in the environment.

Ensure Collaboration Is Easy  
and Efficient
With vast amounts of medical knowledge available today, doctors depend 

on each other for specialized expertise. Medical assistants might notice 

things doctors miss. And technicians are on the front lines, delivering the 

critical diagnostic aids doctors need. With so many players involved in 

healthcare, collaboration is key for accurate communication and diagnoses. 

The devices used are a significant factor in determining whether that 

collaboration is effective or ineffective.

For our clinical collaboration testing for rich-client against zero-client 

devices, we chose Intel® Unite™ software.

In our test, Jim wants to review the X-ray he’s just taken of Don’s spine 

with Dr. Zone. Dr. Zone is in a distant wing of the facility, so a face-to-face 

consult is not realistic. Jim uses the all-in-one in the radiology lab to initiate 

a peer-to-peer connection with Dr. Zone using Intel Unite software. He 

uses chat in the facility’s Savance Health solution to send the PIN for the 

conference to Dr. Zone. Within seconds, he and Dr. Zone are connected.

Jim shares the X-ray with Dr. Zone and discusses the annotation that he made previously. Dr. 

Zone determines that Jim’s concerns are well founded, and an additional X-ray is the best next 

step. Within Intel Unite software, Dr. Zone circles a specific part of the X-ray as he talks, to 

show Jim an area to focus on in the next X-ray.

Because Don—the patient—is still in radiology, Jim takes the second X-ray right away. Don is 

saved from making the trip back to Dr. Zone’s clinic only to be told he needs to go back for 

another X-ray. Don avoids wasted time, extra hassle, and unneeded worry. 

The second X-ray rules out any significant concerns, and Dr. Zone starts Don off with physical 

therapy and muscle relaxants.

INTEL® UNITE™ SOFTWARE 
FOR CONFERENCE ROOMS
After a one-time software install  
on a Windows® or macOS™ device, 
Intel Unite software (www.intel.com/
unite) for conference rooms enables 
colleagues near or far to connect 
screens and audio. Users simply 
share the six-digit PIN shown on  
the display with those with whom 
they want to connect, and then  
they press a button to start 
sharing a screen. The 256-bit 
Secure Sockets Layer (SSL) data 
encryption helps protect the shared 
data, and all data traffic remains 
safely within the network.
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In our test, if Jim had been tethered to the zero client we tested, he would not have been able 

to initiate a peer-to-peer connection with Dr. Zone. He would first have had to contact Dr. Zone 

or one of Dr. Zone’s admins and ask that one of them initiate the connection using an Intel 

processor–powered device. Those added steps would have meant more waiting and time 

wasted for Don, Jim, Dr. Zone, and the admin. 

The rich-client devices also outperform the zero-client device in our test. Jim and Dr. Zone 

are able to complete their collaboration in just 14.43 seconds with both participants using the 

Lenovo ThinkCentre M900z all-in-one device powered by an Intel Core i5-6500 processor with 

Intel vPro technology. The same consult takes 20.36 seconds—5.93 seconds longer—if one of 

the two participants uses the zero client. That makes the Lenovo ThinkCentre M900z all-in-one 

29 percent faster for this task. If both users are on a Lenovo ThinkPad X1 Tablet, powered  

by an Intel Core m7-6Y75 

processor with Intel vPro 

technology, the task takes just 

17.21 seconds—making the tablet 

3.15 seconds, or 15 percent,  

faster than the zero client.

Rich-Client Devices Enable Collaboration without Delays  
or Limited Capabilities
Using an Intel processor–powered rich-client device not only lets Jim complete his radiology 

tasks more efficiently, it also gives him the capability to quickly and efficiently collaborate with 

doctors and others. Our recommendation for collaboration in healthcare settings is rich-client 

devices powered by Intel processors.

Enable online collaboration that 
is 15 to 29 percent faster 
with an Intel® processor–powered 
rich client.

Peer-to-peer connection screen on the Lenovo® 
ThinkCentre® M900z all-in-one device

Figure 1. The zero client that we tested was unable to initiate a peer-to-peer connection using Intel® Unite™ 
software; it could be used to participate when another device initiated the connection, but it could not be used  
to initiate the connection itself

Peer-to-peer connection screen on the zero client
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The Virtual-Desktop-Infrastructure (VDI) Reality
Healthcare organizations are often drawn to a virtual-desktop-infrastructure (VDI) model where 

zero or thin clients are used with a desktop operating system hosted inside a virtual machine 

running on a centralized server. The perception that these devices are cheaper makes this 

model seem more affordable. However, the initial cost of acquiring zero or thin clients does 

not include peripherals, the time needed to install drivers for peripherals, or management and 

maintenance time, and is therefore not necessarily the most important contributing factor to 

total cost of ownership (TCO) of a VDI implementation.

A VDI environment capable of meeting the complex needs of a healthcare setting might  

actually cost more up front and can require added investments going forward. One limiting 

factor is the dependency on network bandwidth. If the network goes down, or if too many 

users are consuming bandwidth—with video conference calls for example—clinicians will not 

be able to fully use their devices. Performance could be slow or non-existent, crucial features 

might not work, and so on. That could require IT to add costly infrastructure in order to 

increase bandwidth.

A VDI environment also requires added costs to equip zero clients with the necessary 

peripherals, including monitors, keyboards, mice, cameras, and other items. None of these 

items come with a zero client. Additionally, connecting zero clients to peripherals, printers, 

and legacy devices can be more complicated in a VDI configuration. Zero or thin clients can 

lack the required drivers, making zero clients more time-consuming to deploy at the outset 

and harder to upgrade in the future. Add in the extra costs of meeting different licensing 

requirements or the burden of preparing staff for significant changes in their computing 

resources, and the total deployment expenses can quickly spiral upward.

Simulating a VDI
To simulate a VDI environment without the complex overhead typically required, we ran our 

zero client in a virtual machine running Windows MultiPoint Server 2012. The zero client 

streamed a desktop in the style of the Windows® 8 operating system, in addition to streaming 

the software used in our testing. 
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Intel® Processor–Powered Rich-Client Devices 
Deliver More Efficiency and More Options  
for Clinicians
In our testing, we found the zero client underperformed when compared to the Intel 

processor–powered rich-client devices. Additionally, rich-client devices support broader 

options for users along with mobility when needed. They also provide the best assurance that 

new applications and changes in the technology landscape are supported by users’ devices in 

the long term.

When evaluating device choices, it is important to choose the best device for the individual 

task and overall workflow. Based on our research and the devices we tested, Prowess 

Consulting recommends healthcare IT decision makers choose rich-client devices powered  

by Intel processors for healthcare clinicians and staff.

“The gap between zero clients and tablets or all-
in-ones is shortening every day. And there are real 
problems with maintaining a zero-client environment; 
not to mention that they are totally inflexible if you 
change your mind.”  
— Julian Lancaster, IT Manager, Prowess Consulting
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Appendix A: Hardware and Test Environment 
Devices

Form Factor All-in-one Tablet Zero client

Model Lenovo® ThinkCentre® M900z Lenovo® ThinkPad® X1 Tablet 1003-E03 SKU#662724309007

Processor Intel® Core™ i5-6500 processor, 3.2 
GHz, four cores, up to 3.6 GHz with 
Intel® Turbo Boost Technology and 
with Intel® vPro™ technology

Intel Core m7-6Y75 processor, 1.2 
GHz, two cores, up to 3.1 GHz with 
Intel Turbo Boost Technology and 
with Intel vPro technology

No CPU

Cache 6 MB Intel® Smart Cache 4 MB Intel Smart Cache Not applicable (N/A)

RAM 4 GB 16 GB N/A

OS Windows® 10 Pro (64-bit edition) Windows 10 Pro (64-bit edition) Windows® MultiPoint® Server 2012 
with 6 GB RAM, four cores, and 
100 GB storage

Graphics Intel® HD Graphics 515 Intel HD Graphics 515 N/A

Ports •	 6 USB 3.0 ports (one always-on 
fast-charge USB)

•	 9-in-1 card reader (optional)

•	 Headphone and microphone 
combo port 

•	 DisplayPort™ in and out combo 

•	 AC-in

•	 RJ45 LAN connector

•	 Serial port (optional)

•	 1 USB 3.0

•	 1 USB Type-C™ power delivery

•	 Mini DisplayPort (mDP)

•	 microSD™

•	 Audio

•	 Nano SIM

•	 1 Video Graphics Array (VGA)

•	 4 USB 2.0

•	 1 microphone

•	 1 audio line-out

•	 1 LAN (Gigabit Ethernet [GbE])

Camera Up to 1,080p 2 megapixels (MP) or 8 MP with 
flash, 1,080p 

N/A

Display Size and Resolution 23.8" (604.5 mm) full high definition 
(FHD) 1,080p (1,920 x 1,080) thin-
film-transistor (TFT) color, WVA 
panel, wide viewing angle (+/– 89 
degrees), light-emitting diode (LED) 
backlight, 250 nits, 16:9 aspect 
ratio, 1,000:1 contrast ratio, anti-
glare for both touch models and 
non-touch models, works as a 
standalone monitor via DisplayPort 
(in/out combo)

12.0" (304.8 mm) FHD+ (2,160 
x 1,440), glare, LED backlight, 
in-plane switching (IPS), anti-
fingerprint display with Corning® 
Gorilla® Glass, wide view (170 
degree viewing), 360 nits, 3:2 
aspect ratio, 800:1 contrast ratio

N/A

Weight 17.20 lbs 1.69 lbs N/A

Dimensions (W x D x H) 11.8 x 8.4 x 0.3 in 15.09 x 10.1 x 0.76 in 3.4 x 0.7 x 5.2 in

Wireless Intel® Dual Band Wireless-AC 8260 
802.11 a/b/g/n/ac (2 x 2) wireless 
and Bluetooth® 4.2 combo

Intel Dual Band Wireless-AC 8260 
802.11 a/b/g/n/ac (2 x 2) wireless 
and Bluetooth 4.2 combo

N/A

Software

Savance Health Patient Self  
Check-In

9.0.76 9.0.76 9.0.76

Savance Health Patient Tracking 
& Flow with Savance Health 
EIOBoard for the backend

9.0.113 9.0.113 9.0.113

Dragon® Medical Practice Edition 2 2 2

Intel® Unite™ software 2.0.27.10 2.0.27.10 2.0.27.10

ObjectiveView™ image viewer 1.46 1.46 1.46

Notepad 1511 1511 1511

File Sizes Used in Prowess Use Cases

X-ray image 523 KB

Medical recording (m4a) 2.15 MB

Medical recording (mp3) 942 KB
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Appendix B: Functional Use Case Steps and Findings 
Patient Check-in with Savance Health Patient Self Check-In

Using Keyboard

1.	 From the desktop, double-click the Savance Health - Patient Self Check-In icon.

2.	 Click Sign in.

3.	 In the First Name field, type Don.

4.	 In the Last Name field, type Anderson.

5.	 In the Birthdate Month field, type 05.

6.	 In the Birthdate Day field, type 28.

7.	 In the Birthdate Year field, type 1945.

8.	 Click Next.

9.	 In response to all five questions, click No.

10.	 Click Confirm.

Using Touch

1.	 From the desktop, double-tap the Savance Health – Patient Self Check-In icon.

2.	 Tap Sign in.

3.	 In the First Name field, type Don.

4.	 In the Last Name field, type Anderson.

5.	 In the Birthdate Month field, type 05.

6.	 In the Birthdate Day field, type 28.

7.	 In the Birthdate Year field, type 1945.

8.	 Tap Next.

9.	 In response to all five questions, tap No.

10.	 Tap Confirm.

Add a New Patient in Savance Health EIOBoard

1.	 From the desktop, double-click the EIOBoard icon.

2.	 From the top menu bar, click the Administrator icon.

3.	 From the bottom of the screen, click the User Type drop-down menu, and then select Patient.

4.	 Click New.

5.	 In the First Name field, type Betty.

6.	 In the Last Name field, type Marshall.

7.	 In the Email Address field, type b.marshall@gmail.com.

8.	 In the Phone Number field, type 801-555-0199.

9.	 In the Cell Phone field, type 801-555-0188.

10.	 In the DOB field, type 01/15/1967.

11.	 In the Home Phone field, type 801-555-0199.

12.	 In the Home Email Address field, type b.marshall@gmail.com.

13.	 In the Home Address field, type 1025 Big Blvd Way.

14.	 In the Home City field, type Somewhere.

15.	 In the Home State field, type UT.

16.	 In the Home Zip field, type 111111.

17.	 In the Receptionist Comment field, type Insurance verified.

18.	 Click Add.

Change Patient Status to “Waiting” in Savance Health Patient Tracking & Flow

1.	 With Savance health EIOBoard open, double-click Don Anderson.

2.	 Click Waiting.

3.	 Click Okay.
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Chat with a Colleague in Savance Health Patient Tracking & Flow

1.	 With Savance Health Patient Tracking & Flow open, from the top menu bar, click the More drop-down menu.

2.	 Click Chat.

3.	 Select the user with whom you wish to chat.

4.	 Click OK.

5.	 Type Can you call Dr. Todd’s office and get Don Anderson’s records?1

6.	 Press Enter.

Change a Patient’s Status to “Discharged” in Savance Health Patient Tracking & Flow

1.	 With Savance Health EIOBoard open, double-click Don Anderson.

2.	 Click Discharged.

3.	 Click Okay.

Record Exam Notes in Dragon® Medical Practice Edition

1.	 From the desktop, double-click the Dragon Medical Practice Edition icon.

2.	 On the Windows task bar, double-click the Notepad icon to open Notepad.

3.	 Click the red square to turn the microphone on.

4.	 Read the note out loud, making sure to mention all line breaks and punctuation.

5.	 Click File > Save As.

6.	 Double-click OneDrive.

7.	 Double-click the Marshall_Betty folder.

8.	 In the Filename field, type Marshall, Betty_Notes.

9.	 Click Save.

Transcribe Recorded Exam Notes in Dragon Medical Practice Edition

1.	 From the desktop, double-click the Dragon Medical Practice Edition icon.

2.	 Click Tools > Transcribe Recording > Next > Browse to locate file > Documents.

3.	 Double-click Marshall-Betty_Notes.mp3.

4.	 Click Transcribe.

View/Annotate an X-ray Image in ObjectiveView™ Digital-Pathology Viewer

1.	 From the desktop, double-click the ObjectiView icon.

2.	 Click File > Open File > OneDrive.

3.	 Double-click the Anderson, Don folder.

4.	 Double-click CSPine3of4.jpg.

5.	 Click Annotation Tool.

6.	 Click the ruler icon.

7.	 Click and hold at the bottom of skull, and then draw a line to the top of the fifth vertebrae.

8.	 In the comment box, type DB: What are your thoughts on this?

9.	 Click Annotation Tool.

10.	 Click the pointer icon.

11.	 Click at the top of the seventh vertebrae and drag up and to the left to make a pointer.

12.	 In the comment box, type DB: Does this look okay to you?

13.	 Click X in the top right corner of the application to close the application.

14.	 Click Yes to save the annotations.

Collaborate to Discuss an X-ray Using Intel Unite Software 

1.	 From the desktop, double-click the Unite icon.

2.	 Click Start Peer to Peer.

3.	 When the request to join pops up, click Accept.

4.	 Click Present Desktop.

5.	 Click Annotation Tool.

6.	 Click the circle icon.

7.	 Click to the left of the bottom of the second vertebrae and drag to the top right of the third vertebrae.

8.	 In the comment box, type RS: Check with Bob on this.

9.	 Click X in the top right corner of the application to close the application.

10.	 Click Yes to save the annotation.
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Functionality Test Results

Lenovo® 
ThinkCentre® 
M900z, powered by 
an Intel® Core™ i5-
6500 processor

Lenovo® 
ThinkPad® X1 
Tablet, powered 
by an Intel 
Core m7-6Y75 
processor

Zero client with a 
virtualized desktop 
hosted on a server 
running Windows® 
MultiPoint® Server 2012

Comparison: 
Difference using 
Lenovo ThinkCentre 
M900z compared to  
the zero client

Comparison: 
Difference using the 
Lenovo ThinkPad X1 
Tablet compared to 
the zero client

Patient check-in with 
Savance Health Patient 
Self Check-In (using 
the keyboard)

19.89 seconds 27.76 seconds 20.34 seconds 0.45 seconds faster 7.42 seconds slower

Patient check-in with 
Savance Health Patient 
Self Check-In (using 
touch)

20.76 seconds 22.65 seconds N/A N/A N/A

Add a new patient 
in Savance Health 
EIOBoard

57.19 seconds 68.66 seconds 59.86 seconds 2.67 seconds faster 8.80 seconds slower

Change a patient’s 
status to “Waiting” in 
Savance Health Patient 
Tracking & Flow

7.46 seconds 5.78 seconds 11.75 seconds 4.29 seconds faster 5.97 seconds faster

Chat with a colleague 
in Savance Health 
Patient Tracking & 
Flow

20.69 seconds 22.19 seconds 24.59 seconds 3.90 seconds faster 2.40 seconds faster

Change a patient’s 
status to “Discharged” 
in Savance Health 
Patient Tracking & 
Flow

4.16 seconds 5.41 seconds	 4.67 seconds 0.51 seconds faster 0.74 seconds slower

Record exam notes 
in Dragon® Medical 
Practice Edition

116.89 seconds 122.76 seconds 141.71 seconds 24.82 seconds faster 18.95 seconds faster

Transcribe recorded 
exam notes in Dragon 
Medical Practice 
Edition

37.16 seconds 50.84 seconds 72.05 seconds 34.89 seconds faster 21.21 seconds faster

View/annotate an 
X-ray image in 
ObjectiveView™ digital-
pathology viewer

36.17 seconds 41.38 seconds 42.00 seconds 5.83 seconds faster 0.62 seconds faster

Collaborate to discuss 
an X-ray using Intel® 
Unite™ software

14.62 seconds 17.21 seconds 20.36 seconds 5.74 seconds faster 3.15 seconds faster

 
All times shown are the median of three test runs. Margins of error run from +/– 0.03 percent to +/– 10.13 percent.



1 Betty Marshall, Mike, Don Anderson, Susan, Dr. Zone, Dr. Todd, and Jim are fictional composites. All patient data is fictitious.
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